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terms and conventions

The following terms and conventions are used in the user's guide.

terms

The HP Deskjet printer may be referred to as the HP printer or printer.

symbols

The > symbol guides you through a series of software steps. For example:

Click File > Print.

cautions and warnings

A Caution indicates possible damage to the HP Deskjet printer or to other equipment. For 
example:

Caution!   Do not touch the print cartridge ink nozzles or copper contacts. 
Touching these parts will result in clogs, ink failure, and bad electrical 
connections.

A Warning indicates possible harm to you or to others. For example:

 
Warning!   Keep both new and used print cartridges out of the reach of 
children.

icons

A Note icon indicates that additional information is provided. For example:

 For great results use HP products.

A Mouse icon indicates that additional information is available through the What's This? 
help feature. For example:

 

To find more information about options on each tab screen, point to an 
option and click the right mouse button to display the What's This? 
dialog box. Click What's This? to view information about the selected 
option.

A Do Not icon indicates that an action is not recommended.

 Do not clean the interior of the printer.



accessibility 

Your HP printer provides a number of features that make it accessible for people with 
disabilities. 

visual 

The printer software is accessible for users with visual impairments or low vision through 
the use of Windows accessibility options and features. It also supports most assistive 
technology such as screen readers, Braille readers, and voice-to-text applications. For 
users who are color blind, colored buttons and tabs used in the software and on the HP 
printer have simple text or icon labels that convey the appropriate action. 

mobility 

For users with mobility impairments, the printer software functions can be executed 
through keyboard commands. The software also supports Windows accessibility options 
such as StickyKeys, ToggleKeys, FilterKeys, and MouseKeys. The printer doors, buttons, 
paper trays, and paper guides can be operated by users with limited strength and reach. 

support 

For more details about the accessibility of this product and HP's committment to product 
accessibility: 

●     Visit HP's Web site at: www.hp.com/accessibility 

●     Email HP at: accessibility@hp.com 



special features

Congratulations! You have purchased an HP Deskjet printer that is equipped with several 
exciting features:

●     Print Quality Selector: Select the print quality from the front of the printer.

●     Borderless printing: Use the entire page surface when printing photos and cards 
using the borderless printing feature.

●     Print screen: Prints the image displayed on your computer's monitor at the touch 
of a button.

●     Six-ink upgradeable printing: Enhance photo printing with a photo print cartridge.

●     Digital photo printing: Enhanced digital photo printing capabilities.

●     Ink-backup mode: Ink-backup mode lets you continue printing with one print 
cartridge when the other print cartridge has run out of ink.

●     Auto-on and Auto-off: Enable the auto-off feature to place the printer into a low-
power, energy-efficient mode after it has been idle for 30 minutes. The printer turns 
on automatically when you print a file.

●     Print multiple pages on a single sheet of paper: Use the printer software to 
print up to 16 pages on a single sheet of paper.

●     Print Cancel button: Cancel print jobs at the touch of a button.

●     Optional Two-Sided Printing Accessory: Purchase a Two-Sided Printing 
Accessory to print two-sided documents automatically.

 



selecting a print quality

The printer offers two methods for selecting a print quality:

●     printer software 

●     print quality selector 

printer software

Follow these steps to select a print quality from the printer software:

1.  Open the Printer Properties dialog box.

2.  Select the Paper/Quality tab.

 

3.  Select one of the following from the Print Quality drop-down list:

❍     Use Print Quality Selector: Enables the Print Quality Selector button.

❍     FastDraft: Prints at the fastest printing speed while using the least amount of ink.

❍     Fast Normal: Prints faster than Normal mode and at a higher print quality than 
FastDraft.

❍     Normal: Prints faster than Best and at a higher quality than Fast Normal. This 



mode is appropriate for most print jobs and is the minimum print quality required 
to use digital photography options.

❍     Best: Provides high quality printing.

❍     Maximum dpi: Provides highest quality printing but requires longer to print than 
Best and requires a large amount of disk space

print quality selector

Use the Print Quality Selector button to set print quality and print speed from the front of 
the printer.

 
1. print quality selector button

enabling the print quality selector button

Before using the Print Quality Selector button, you must enable it from the printer software.

Follow these steps to enable the Print Quality Selector button:

1.  Open the Printer Properties dialog box.

2.  Select the Paper/Quality tab.

3.  Select Use Print Quality Selector from the Print Quality drop-down list.

4.  Click OK.

using the print quality selector button

Use the Print Quality Selector button to specify the print quality for documents you plan to 
print. You cannot change the print quality for a document once the document begins 
printing.

Follow these steps to use the Print Quality Selector button:



1.  Verify that the Print Quality Selector button is enabled from the printer software.

2.  Press the Print Quality Selector button to select one of the following print qualities:

 

Fast 
Normal 

 

Normal 

 

Best 

 

FastDraft and Maximum dpi can only be selected from the printer 
software. If a document is printed in either the FastDraft or Maximum dpi 
mode, the currently selected print quality icon flashes until the 
documented is finished printing.

lights

The Print Quality Selector icons light up or flash to indicate the selected print quality:

if... then...

One icon is lit The illuminated icon is the selected print quality.

One icon is lit and another flashes

The illuminated icon is the selected print quality 
for the current print job.
The flashing icon is the selected print quality for 
the next print job.

One icon flashes
Either FastDraft or Maximum dpi has been 
selected as the print quality from the printer 
software.



print settings

The printer is controlled by software installed on your computer. Use the printer software, 
known as the printer driver, to change the print settings for a document.

To change the print settings, open the Printer Properties dialog box.

displaying the printer properties dialog box

Follow these steps to display the Printer Properties dialog box:

1.  Open the file you want to print.

2.  Click File > Print, then select Properties. The Printer Properties dialog box appears.

 
The path to the Printer Properties dialog box may vary depending on the 
software program.

using the printer properties dialog box

The Printer Properties dialog box has several tools that make it easy to use.

buttons and menus

The Printer Properties dialog box has the following features:



 

1.  Tabs: Click a tab to see its contents.

2.  Print Task Quick Sets: See print task quick sets.

3.  Preview: Shows how changes to the print settings affect the printout.

4.  Buttons:

❍     OK: Saves and applies changes.

❍     Cancel: Closes the dialog box without saving the new settings.

❍     Help: Offers instructions for using the What's This? help feature.

An Apply button may also appear. The Apply button saves changes to the settings 
without closing the dialog box.

 
To find more information about options on each tab screen, point to an 
option and click the right mouse button to display the What's This? dialog 
box. Click What's This? to view more information about the selected item.

tabs

●     paper/quality tab 

●     finishing tab 



●     effects tab 

●     basics tab 

●     color tab 

 
Printer features, and instructions on how to use them, are subject to 
change. This document was released for publishing before all of the 
printer features were determined.



print task quick sets

Use print task quick sets to print with or save print settings you use often.

For example, if you frequently print envelopes, you can create a print task that contains 
the paper size, print quality, and orientation setting you normally use for envelopes. After 
creating the print task, simply select it when printing envelopes rather that setting each of 
the print settings separately.

Create your own print task or use the specially designed print tasks available in the Print 
Task Quick Sets drop-down list.

using a print task quick set

Follow these steps to use a print task quick set:

1.  Open the Printer Properties dialog box.

2.  Select the print task you want to use from the drop-down list.

 

3.  Click OK.



 
To restore default print settings, select Default Print Settings from the 
Print Task Quick Sets drop-down list, and click OK.

creating a print task quick set

Follow these steps to create a print task quick set:

1.  Open the Printer Properties dialog box.

 

2.  Select the options you want to include in the new print task.

3.  Enter a name for the new print task in the Print Task Quick Sets drop-down list, then 
click Save.

The print task quick set is added to the drop-down list.

 
If you add more options to the print task, you must rename the print 
task, then click OK.

deleting a print task quick set

Follow these steps to delete a print task quick set:

1.  Open the Printer Properties dialog box.



2.  Select the print task you want to delete from the drop-down list, then click Delete.

 Some print task quick sets cannot be deleted.



paper quality tab

The Paper/Quality tab allows you to set these options:

 

1.  Print Task Quick Sets: See print task quick sets.

2.  Size is: Size of paper used.

3.  Custom: See setting a custom paper size.

4.  Source is: See selecting a paper source.

5.  Type is: See selecting a paper type.

6.  Minimize Margins: Select to print closer to the bottom edge of the page. This 
feature may cause ink to smear on certain paper types.

7.  Borderless Auto Fit: Select to fit the printed image across the entire page when 
printing a borderless document on certain paper types.

8.  Print Quality: See selecting a print quality.

9.  hp Digital Photography: See printing digital photographs.

10.  Printing Tips: Printing ideas.



setting a custom paper size

Use the Custom Paper Size dialog box to print on a special paper size.

defining a custom paper size

Follow these steps to define a custom paper size:

1.  Open the Printer Properties dialog box.

2.  Click the Paper/Quality tab.

 

3.  Click the Custom button.

The Custom Paper Size dialog box is displayed.



 

4.  Select a custom paper size name from the Name drop-down list.

5.  Enter the paper dimensions in the Width and Length boxes.

The minimum and maximum paper dimensions appear beneath each of the boxes.

6.  Select the unit of measurement: Inches or Millimeters.

7.  Click Save to save the custom paper size.

You can save up to five custom paper sizes.

8.  Click OK to exit the Custom Paper Size dialog box.



selecting a paper source

The printer offers the following paper source options:

●     in tray 

●     250-sheet plain paper tray accessory 

 
The 250-Sheet Plain Paper Tray Accessory is not included with your 
printer, but may be purchased separately from an authorized HP dealer. 
The accessory is not available in all countries/regions.

Follow these steps to select a paper source:

1.  Open the Printer Properties dialog box.

2.  Select the Paper/Quality tab.

 

3.  Select one of the following options in the Source is drop-down list:

❍     Upper Tray: Prints from the In tray.

❍     Lower Tray: Prints from the 250-Sheet Plain Paper Tray Accessory.



❍     Upper, then Lower: Prints from the In tray. If the In tray is empty, the printer 
prints from the 250-Sheet Plain Paper Tray Accessory.

❍     Lower, then Upper: Prints from the 250-Sheet Plain Paper Tray Accessory. If the 
accessory is empty, the printer prints from the In tray.



paper trays

The printer has two paper trays: an In tray and an Out tray.

 
1. out tray 2. in tray

in tray

The In tray holds paper or other media to be printed.

Slide the paper guides firmly against the edges of the media on which you are printing.

 
1. in tray 2. paper width guide 3. paper length guide

out tray

Printer pages are deposited in the Out tray.

Raise the Out tray to load most paper sizes. Remove the Out tray to load small media.



 

Replace the Out tray before printing.

 

To prevent paper from falling out of the Out tray, pull out the Out tray extension.

 
1. out tray extension

When printing in FastDraft mode, pull out the Out tray extension, then unfold the Out tray 
extension stop.

 



1. out tray extension 2. out tray extension stop

 Do not unfold the Out tray extension stop when printing on legal paper.

After the print job finishes, fold the Out tray extension stop, then push the Out tray 
extension into the Out tray.

 



250-sheet plain paper tray accessory

The 250-sheet Plain Paper Tray Accessory expands the paper capacity of your printer to 
400 sheets. It is useful for high-volume printing and for occasions when you want to use 
the In tray for special media such as letterhead paper, but still have plain paper readily 
available.

If the 250-Sheet Plain Paper Tray Accessory is not included with your printer, it may be 
purchased separately from an authorized HP dealer.

 
The 250-Sheet Plain Paper Tray Accessory is not available in all countries/
regions.

For information about the 250-Sheet Plain Paper Tray Accessory, select one of the topics 
below:

●     installing the 250-sheet plain paper tray accessory 

●     accessory description 

●     setting the paper size 

●     loading the lower tray 

installing the 250-sheet plain paper tray accessory 

Follow these steps to install the 250-Sheet Plain Paper Tray Accessory:

1.  Turn off the printer.

2.  Select a location for the printer and place the 250-Sheet Plain Paper Tray Accessory 
in this location.

3.  Carefully lift the printer and orient it above the paper tray.

 

4.  Gently place the printer on top of the paper tray.



using the 250-sheet plain paper tray accessory

accessory description

The 250-Sheet Plain Paper Tray Accessory has two parts.

 
1. base 2. lower tray

The lower tray has three size adjusters.

 
1. paper width guide 2. paper width fence 3. paper length guide

 
When changing the paper size in the paper tray, you must set all three 
paper guides.

setting the paper size

When changing the paper size in the paper tray, all three paper guides must be set to the 
correct setting.

Follow these steps to set the paper size:

1.  Remove the lower tray from the base.



 

2.  Slide the paper width guide until the arrow is even with the correct setting.

 
1. align the arrows

 To print on legal-sized paper, set the paper width guide to LTR.

3.  Set the paper width fence by carefully inserting it into the appropriate sized slot.

 
1. tilt the fence forward. 2. insert the fence into the appropriate slots 3. tilt the fence 
back until it locks into place



 To print on legal-sized paper, set the paper width fence to LTR.

4.  Set the paper length guide by pulling it until the arrow lines up with the paper size.

 
1. align the arrows

 
To print on legal-sized paper, pull the paper length guide all the 
way out.

loading the lower tray

Follow these steps to load paper:

1.  Verify that all three paper guides are set to the correct setting.

2.  Insert the paper into the lower tray.

 

3.  Insert the lower tray in the base until it locks into place.



 

printing instructions

For instructions on printing with the 250-Sheet Plain Paper Tray Accessory, click here.
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C6518A hp USB A-B 2M cable 
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C8955A automatic two-sided printing module

C8990A hp 250 sheet paper tray
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borderless printing

Borderless printing lets you print to edges of certain paper types and a range of standard 
paper sizes from L size (89 x 127 mm) to Letter (8.5 x 11 in) and A4 (210 x 297 mm). The 
printer can also print on 4 x 6 inch photo paper with a tear-off tab.

guidelines

●     Do not print borderless documents in ink-backup mode. Always have two print 
cartridges installed in the printer.

●     Open the file in a software application and assign the image size. Ensure that the 
size corresponds to the paper size on which you want to print the image.

printing

Follow these steps to print a borderless document:

1.  Open the file you want to print.

2.  Open the Printer Properties dialog box.

3.  Select one of the borderless paper sizes from the Size is drop-down list. Verify that 
the paper size you select matches the size of the paper loaded in the In tray.

 



4.  Select the appropriate paper type in the Type is drop-down list. Do not select 
Automatic.

5.  Click the Borderless Auto Fit checkbox to automatically resize the image to print 
without a border.

 
The Borderless Auto Fit option is only available for photo paper 
types.

 

6.  Select any other desired print settings, then click OK.

If you printed on photo paper with a tear-off tab, remove the tab to make the 
document completely borderless.



 



ink-backup mode

Ink-backup mode allows the printer to operate using only one print cartridge. It is initiated 
when a print cartridge is removed from the cradle.

For instructions on removing a print cartridge, click here.

ink-backup mode output

Printing in ink-backup mode slows the printer and affects the quality of printouts.

when only this print cartridge is 
installed... the result is...

black print cartridge Colors are printed as grayscale.

tri-color print cartridge Colors print but black is grayed and is 
not a true black.

photo print cartridge Colors are printed as grayscale, black 
is grayed and is not a true black.

 
It is recommended that you do not use the photo print cartridge for ink-
backup mode.

exiting ink-backup mode

Install two print cartridges in the printer to exit ink-backup mode.

For instructions on installing a print cartridge, click here.



replacing print cartridges

Before buying replacement print cartridges, verify the correct part numbers.

The printer can operate with only one print cartridge installed. For more information click 
here.

To replace a print cartridge:

1.  Load a stack of plain white paper in the In tray.

2.  Press the Power button to turn on the printer.

3.  Open the printer cover.

4.  Lift the print cartridge latch to the open position.

 

5.  Slide the print cartridge out of the print cartridge cradle.

 

6.  Remove the replacement print cartridge from its packaging and carefully remove the 
plastic tape.



Caution!   Do not touch the print cartridge ink nozzles or copper 
contacts. Touching these parts will result in clogs, ink failure, and bad 
electrical connections. Do not remove the copper strips. They are 
required electrical contacts.

 
1. remove plastic tape

7.  Hold the print cartridge so that the copper strip is on the bottom and facing toward 
the printer, then slide the print cartridge into the cradle as shown.

 

8.  Push down on the print cartridge latch until it snaps closed.

9.  Close the top cover.

The printer automatically prints a calibration page.

For information on storing print cartridges, click here.

For information on recycling empty print cartridges, click here.

 
Warning!   Keep both new and used print cartridges out of the reach of 
children.



print cartridges

These print cartridges can be used with the printer.

●     black print cartridge

●     tri-color print cartridge

●     photo print cartridge

 
1. black print cartridge 2. tri-color print cartridge 3. photo print cartridge

Not all print cartridges may be packaged with your printer.

 All print cartridges are not available in all countries/regions.

print cartridge selection

printer model print cartridge selection number product number

HP Deskjet 5600 
Series 

black 56 c6656

tri-color 57 c6657

photo 58 c6658

For installation instructions, click here.

For storage instructions, click here.

For recycling instructions, click here.

 
For print cartridge ink capacity, see the information included in the print 
cartridge packaging.

To get the best performance from your HP printer, use only genuine, factory-filled HP print 
cartridges. 

Caution!   Damage that is directly attributable to modified or refilled HP 
print cartridges is specifically excluded from the HP printer's warranty 



coverage. 



maintaining print cartridges

The following tips will help maintain HP print cartridges and ensure consistent print quality:

●     Keep all print cartridges in their sealed packages until they are needed. Print 
cartridges should be stored at room temperatures (15-35 degrees C or 59-95 
degrees F).

●     Do not remove the plastic tape covering the ink nozzles until you are ready to install 
the print cartridge in the printer. If the plastic tape has been removed from the print 
cartridge, do not attempt to reattach it. Reattaching the tape damages the print 
cartridge.

storing print cartridges

When print cartridges are removed from the printer, store them in a print cartridge 
protector or an airtight plastic container.

A print cartridge protector comes with the photo print cartridge. If you store the print 
cartridge in an airtight plastic container, make sure that the ink nozzles face down but are 
not in contact with the container.

inserting the print cartridge into the print cartridge protector

Slide the print cartridge at a slight angle into the protector, and snap it securely in place.

 

removing the print cartridge from the print cartridge protector

Press down and back on the top of the protector to release the cartridge. Slide the 
cartridge out of the protector.



 

Caution!   Do not drop the print cartridge. Dropping the print cartridge may 
damage it.



print cartridge recovery

Customers interested in recycling their genuine HP print cartridges can participate in HP's 
empty print cartridge return and recycle program. HP offers this program in more countries/
regions than any other print cartridge manufacturer in the world. This program is provided 
as a free service to HP customers as an environmentally sound solution for these products 
at end-of-life. It is not available in all countries/regions.

To participate, simply request postage-paid return envelopes or bulk boxes via the Web at 
www.hp.com/recycle.

Because HP's unique recycling processes are very sensitive to material contamination, we 
cannot take back and recycle cartridges from other manufacturers. The end products of the 
recycling process are used in the manufacture of new products, and HP must ensure the 
composition of the material is consistent. To do that, we recycle only HP original cartridges. 
This program does not extend to refilled cartridges.

Returned cartridges are separated for purification into raw materials for use in other 
industries to manufacture new products. Examples of products made from recycled HP 
print cartridge materials include automobile parts, trays used in microchip fabrication 
processes, copper wire, steel plates, and the precious materials used in electronics. 
Depending on the model, HP is able to recycle up to 65% of the print cartridge by weight. 
The remaining parts that cannot be recycled (ink, foam, and composite parts) are disposed 
of in an environmentally responsible manner.



printing a screen image

Use the HP Print Screen Utility to print the image displayed on your computer's monitor.

configuring the hp print screen utility

Follow these steps to configure the HP Print Screen Utility:

1.  Go to printer utilities, then click print screen.

2.  Select the following configuration options as desired:

❍     Unload/Load HP Print Screen: Activates or deactivates the utility.

❍     Start with Windows: Sets the utility to start when Windows is started.

❍     Capture screen: Prints the screen image.

❍     Orientation: Toggles between landscape and portrait mode.

3.  Click OK.

printing instructions

Follow these steps to print a screen image:

1.  Verify that the HP printer is your computer's default printer.

2.  Load either Letter or A4 paper in the In tray.

3.  Do one of the following:

❍     To print the entire desktop: Press the Print Screen key on the keyboard.

❍     To print only the active window: Press the Alt key and the Print Screen key 
simultaneously.
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utilities

HP provides utilities to gather information 

about the printer, to maintain the printer, and 

to update HP software.
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search 



printing digital photographs

The printer has several features to enhance the quality of digital photographs.

opening the hp digital photography options dialog box

Follow these steps to open the hp Digital Photography Options dialog box:

1.  Open the Printer Properties dialog box.

2.  Click the Paper/Quality tab, then click the hp Digital Photography button.

using the hp digital photography options dialog box

Use the hp Digital Photography Options dialog box to set these options:

 

1.  Red Eye Removal: Click On to remove or reduce red-eye from the photograph.

2.  Contrast Enhancement: Adjust contrast to preference. Click Automatic to allow 
the printer driver to automatically balance the contrast.

3.  Digital Flash: Lighten dark images. Click Automatic to allow the printer driver to 
automatically balance lightness and darkness.

4.  SmartFocus: Click On to allow the printer driver to automatically focus images.

5.  Sharpness: Adjust image sharpness to preference. Click Automatic to allow the 
printer driver to automatically sharpen the image.



6.  Smoothing: Adjust distortion to preference. Click Automatic to allow the printer 
driver to automatically smooth the image.



auto-on and auto-off feature

auto-on

Auto-on is a default feature of the printer. The printer automatically turns on when you 
print a file.

auto-off

Enable the auto-off feature to place the printer in a low-power, energy-efficient mode after 
it has been idle for 30 minutes.

Follow these steps to activate the auto-off feature:

1.  Go to printer maintenance.

2.  Click Configure the Printer.

3.  Click Configure.

4.  Select Activate the Hardware Auto-off feature.

5.  Click Apply, then click OK.
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printer maintenance

This section provides access to printer 

maintenance and configuration options.



printing multiple pages on a single sheet of paper

The printer software allows you to print multiple pages of a document on a single sheet of 
paper. The printer software automatically resizes the document text and images to fit on 
the printed page.

Follow these steps to print multiple pages of a document on a single sheet of paper:

1.  Open the Printer Properties dialog box.

2.  Click the Finishing tab.

 

3.  From the Pages Per Sheet drop-down list, select the number of pages you want to 
appear on each sheet of paper.

4.  If you want a border to appear around each page image printed on the sheet of 
paper, click the Print Page Borders checkbox.

5.  Select a layout for each sheet of paper from the Page Order Is drop-down list.

6.  Select any other desired print settings, then click OK.



buttons and lights

Use the printer buttons to turn the printer on and off, cancel a print job, restart a print job, 
and select a print quality. The printer lights give you visual cues about the status of the 
printer.

 
1. print cancel button 2. print cartridge status light 3. resume button 4. print quality 
selector 5. power button

print cancel button

Pressing the Print Cancel button cancels the current print job.

print cartridge status symbol and light

The Print Cartridge Status light turns on or flashes when a print cartridge needs service.

resume button and light

The Resume light flashes when an action is required such as loading paper or clearing a 
paper jam. When the problem is solved, press the Resume button to continue printing.

print quality selector and light

Press the Print Quality Selector button to select a default print quality for the printer. The 
Print Quality Selector light indicates the selected print quality.

power button and light

The Power button turns the printer on and off. It may take a few seconds for the printer to 
turn on after pressing the Power button.

The Power light flashes when the printer is processing.



Caution!   Always use the Power button to turn the printer on and off. Using 
a power strip, surge protector, or a wall-mounted switch to turn the printer 
on and off may cause printer failure.



printer lights are on or flashing

what the lights indicate

The printer lights indicate the printer status.

 
1. print cancel button 2. print cartridge status light 3. resume light 4. print quality icon 
lights 5. power light

power light is flashing

the printer is preparing to print

The light stops flashing when the printer has received all data.

resume light is flashing

the printer may be out of paper

1.  Place paper in the In tray or the optional lower tray.

2.  Press the Resume button on the front of the printer.

there may be a paper jam

Follow these instructions to clear a paper jam.

print cartridge status light is on or flashing

if the light is on and not flashing

Check to see if a print cartridge is low on ink.

If a print cartridge is low on ink, consider replacing the print cartridge.



If neither print cartridge is low on ink, press the Resume button. If the Print Cartridge 
Status light remains on, turn off, then turn on the printer.

if the light is on and flashing

Verify that the correct print cartridges are installed.

If you were printing a borderless document when the light started flashing, follow these 
guidelines.

Otherwise, follow these steps:

1.  Open the printer's top cover, remove the black or photo print cartridge, then close 
the cover.

2.  Do one of the following:

❍     If the light is flashing: Open the top cover, replace the print cartridge you 
removed, then remove the tri-color print cartridge. Go to step 3.

❍     If the light is off: There is a problem with the print cartridge you removed. Go to 
step 3.

3.  Manually clean the print cartridge.

After cleaning the print cartridge, reinsert it into the printer.

If the print cartridge status light continues to flash, replace the print cartridge.

print quality icon lights are on or flashing

See selecting a print quality.

all lights are flashing

the printer may need to be restarted

1.  Press the Power button to turn off the printer, then press the Power button to restart 
the printer.

Proceed to step 2 if the lights continue to flash.

2.  Press the Power button to turn off the printer.

3.  Disconnect the printer's power cord from the electrical outlet.

4.  Reconnect the printer's power cord to the electrical outlet.

5.  Press the Power button to turn on the printer.



paper jam

follow these steps

1.  Press the Resume button.

2.  If you are printing labels, verify that a label did not become detached from the label 
sheet while passing through the printer.

if the paper jam is not cleared

printer does not have a two-sided printing accessory attached 

printer has a two-sided printing accessory attached 

printer does not have a two-sided printing accessory attached

1.  Push the two latch handles on the printer's Rear Access Door toward each other, 
then remove the door.

 

2.  Remove the paper jam from the back of the printer, then replace the Rear Access 
Door.

 

3.  Press the Resume button.

4.  Print the document.



printer has a two-sided printing accessory attached

1.  Press the buttons on the left and right sides of the Two-Sided Printing Accessory, 
then remove it from the printer.

 

2.  Remove any paper in the back of the printer.

If the paper jam is cleared, proceed to step 3 below.

If the paper jam is not cleared, proceed to step 1 below.

1.  Press the button on top of the Two-Sided Printing Accessory, then lower the access 
door.

 

2.  Remove any paper from the Two-Sided Printing Accessory, then close the access 
door.

3.  Reinsert the Two-Sided Printing Accessory into the printer until both sides snap into 
place.



 

 
Do not press the buttons on either side of the duplexer when 
installing it in the printer. Use the buttons only when removing the 
duplexer from the printer.

4.  Press the Resume button.



borderless printing problems

When printing borderless printouts, follow these guidelines:

●     Verify that the paper size specified in the Size is drop-down list on the Paper/Quality 
tab matches the size of the paper loaded in the In tray.

●     Select the appropriate paper type in the Type is drop-down list on the Paper/Quality 
tab.

●     If printing in grayscale, select High Quality under Print in Grayscale on the Color tab.

●     Do not print borderless documents in ink-backup mode. Always have two print 
cartridges installed in the printer.

part of the photograph is faded

fading occurs on the edges of a printout

 

Verify that photo paper is not curled. If the photo paper is curled, place the paper in a 
plastic bag and gently bend it the opposite direction of the curl until the paper lies flat. If 
the problem persists, then use photo paper that is not curled.

For instructions on preventing photo paper from curling, click here.

fading occurs near the edges of a printout



 

If fading occurs approximately 1 to 2.5 inches from the edge of a photograph, try the 
following:

●     Install a photo print cartridge in the printer.

●     Open the Printer Properties dialog box, select the Paper Type/Quality tab, then set 
the Print Quality to Maximum dpi.

●     Rotate the image 180 degrees.

streaks appear in a light portion of a printout

 

If streaks appear in a light portion approximately 2.5 inches from one of the long edges of 
a photograph, try the following:

●     Install a photo print cartridge in the printer.

●     Rotate the image 180 degrees.

image is printed at an angle



 

Follow these steps if the image is printed at an angle:

1.  Remove all paper from the In tray.

2.  Load the photo paper correctly in the In tray.

3.  Verify that the paper guides fit firmly against the media.

4.  Follow loading instructions for the media type.

printout has an unwanted border

for most photo paper types

 

If the printout has an unwanted border, then calibrate the printer.

If printing a two-sided document, print the document manually rather than automatically.

for photo paper with a tear-off tab

If the border appears below the tear-off tab, then remove the tab.



 

If the border appears above the tear-of tab, then calibrate the printer.

 

ink smears

Follow these steps if ink smears appear on the back of the printouts, or the paper sticks 
together.

1.  Open the Advanced Features dialog box.

2.  Move the Dry Time slider toward More.

3.  Move the Ink Volume slider toward Light.

 The colors in the image may become lighter.

4.  Click OK.

If the problem persists:

1.  Remove the borderless printing media, then load plain paper in the In tray.

2.  Press and hold down the Resume button until the printer starts printing a self-test 
page, then release the button.



3.  Repeat step 2 until the self-test has no ink smears on the back of the paper.



getting started

For an overview of printer features and optional accessories, click here.

Click the appropriate topic below for a description of a printer feature:

●     buttons and lights 

●     paper trays 

●     print cartridges 

●     automatic paper-type sensor 

●     ink-backup mode 

Click the appropriate topic below for a description of an optional printer accessory:

●     two-sided printing accessory 

●     250-sheet plain paper tray accessory 



printer features

The printer has several features to make printing easier and more efficient.

 

1.  buttons and lights 

2.  paper trays 

 

1.  print cartridges 

2.  automatic paper-type sensor 

3.  ink-backup mode 



 

1.  connectivity 

 

1.  two-sided printing accessory (optional)

2.  250-sheet plain paper tray accessory (optional)



color tab

The Color tab allows you to set these options:

 

1.  Print Task Quick Sets: See print task quick sets.

2.  Print in Grayscale: Prints in shades of gray.

❍     High Quality: Uses the tri-color print cartridge and/or photo print cartridge 
to print high-quality grayscale.

❍     Black Print Cartridge Only: Uses the black print cartridge to print grayscale.

❍     Optimize For Photocopy or Fax: Uses the black print cartridge to print 
grayscale suitable for photocopying and faxing.

3.  Saturation: Adjusts the intensity of printed colors.

4.  Brightness: Adjusts the lightness or darkness of printed colors.

5.  Color Tone: Adjusts the warmth or coolness of printed colors.

6.  Color Space: See digital photography technologies.



digital photography technologies

The printer software offers several technical features for printing digital photgraphs.

●     PhotoREt 

●     4800 x 1200 optimized dpi 

●     Exif Print 

●     Six-ink printing 

●     Color spaces 

PhotoREt printing 

PhotoREt offers the best combination of print speed and quality for your image.

Follow these steps to print with PhotoREt technology:

1.  Open the Printer Properties dialog box.

2.  Select the Paper/Quality tab.

3.  Select Best from the Print Quality drop-down list.

4.  Select any other desired print settings, then click OK.

4800 x 1200 optimized dpi 

4800 x 1200 optimized dpi is the highest quality resolution for this printer. When 4800 x 
1200 optimized dpi is selected in the printer driver, the tri-color printcartridge prints in the 
4800 x 1200 optimized dpi mode. If a photo print cartridge is also installed, the print 
quality is enhanced. A photo print cartridge may be purchased separately if it is not 
included with your printer.

Follow these steps to print in 4800 x 1200 optimized dpi mode:

1.  Open the Printer Properties dialog box.

2.  Select the Paper/Quality tab.

3.  Select the appropriate photo paper type from the Paper Type drop-down list.

4.  Select Maximum dpi from the Print Quality drop-down list.

5.  Select any other desired print settings, then click OK.

printing Exif Print-enhanced photographs 

Exif Print (Exchangeable Image File Format 2.2) is an international digital imaging standard 
that simplifies digital photography and enhances printed photographs. When a photograph 



is taken with an Exif Print-enabled digital camera, Exif Print captures information such as 
exposure time, type of flash, and color saturation, and stores it in the image's file. The HP 
Deskjet printer software then uses this information to automatically perform image specific 
enhancements, resulting in outstanding photographs.

Printing Exif Print-enhanced photos requires:

●     A digital camera that supports Exif Print

●     Exif Print-enabled photo software

●     HP Deskjet printer software that supports Exif Print

●     Windows 98, 2000, Me, or XP

Follow these steps to print Exif Print-enhanced photographs:

1.  Open the file you want to print using Exif Print-enabled photo software.

2.  Open the Printer Properties dialog box.

3.  Select the Paper/Quality tab.

4.  Select the appropriate photo paper type from the Type is drop-down list.

5.  Select Normal or Best from the Print Quality drop-down list.

6.  Select any other desired print settings, then click OK.

The printer software automatically optimizes the printed image.

six-ink color printing 

Use six-ink color printing to enhance the quality of photographs.

For six-ink color printing, a photo and a tri-color print cartridge must beinstalled. A photo 
print cartridge may be purchased separately if it is not includedwith your product.

Follow these steps to print in six-ink color print mode:

1.  Open the Printer Properties dialog box.

2.  Select the Paper/Quality tab.

3.  Select the appropriate photo paper type from the Type is drop-down list.

4.  Select Normal, Best, or Maximum dpi from the Print Quality drop-down list.

5.  Select any other desired print settings, then click OK.

color space 

Color space defines the range of colors that can be printed. The printer software translates 
the colors of your document from their current color space to the color space selected.

The following color spaces are available:



●     sRGB/sYCC

●     Adobe RGB

sRGB/sYCC

sRGB/sYCC is an appropriate color space for most print jobs. It is used for most Web-based 
documents and current imaging devices.

Follow these steps to use the sRGB/sYCC color space:

1.  Open the Printer Properties dialog box.

2.  Select the Color tab.

3.  Select sRGB/sYCC from the Color Space drop-down list.

4.  Select any other desired print settings, then click OK.

Adobe RGB

Adobe RGB is an emerging color space that offers more colors than sRGB/sYCC, but which 
only works for images.

When printing from a professional application using Adobe RGB, turn off the color 
management in the application and allow the printer software to manage the color space.

Follow these steps to use the Adobe RGB color space:

1.  Open the Printer Properties dialog box.

2.  Select the Paper/Quality tab, the select the following:

❍     An HP photo paper from the Type is drop-down list.

❍     Best or Maximum dpi from the Print Quality drop-down list.

3.  Select the Color tab.

4.  Select Adobe RGB from the Color Space drop-down list.

5.  Select any other desired print settings, then click OK.

If the the Adobe RGB color space is used for an image which was created in another color 
space, then printed colors may appear more vivid.



storing and handling photo paper

Follow these instructions to maintain the quality of your HP brand photo paper.

storage

●     Keep unused photo paper in a resealable plastic bag, in the box in which it was 
originally packaged. Store the packaged photo paper on a flat surface in a cool place.

●     When you are ready to print, remove only the paper that you plan to use 
immediately. When you have finished printing, return any unused photo paper to 
the plastic bag.

●     Do not leave unused photo paper in the printer's paper tray. The paper may start to 
curl, which can reduce the quality of your photographs.

handling

●     Always hold photo paper by the edges. Fingerprints on photo paper can reduce print 
quality.

●     If the corners of the photo paper curl more than 10 mm or 3/8 inch, flatten the 
paper by putting it in the resealable storage bag, then rolling the bag on a table 
edge until the paper is flat.

Photo paper should be flat before printing.



finishing tab

The Finishing tab allows you to set these options:

 

1.  Print Task Quick Sets: See print task quick sets.

2.  Print on Both Sides: See two-sided printing.

3.  Booklet Layout is: See printing a booklet.

4.  Pages per Sheet: See printing multiple pages on a single sheet of paper.

5.  Poster Printing: Select the number of pages you want your poster printed across 
to determine the size of your poster.

6.  Rotate By 180 Degrees: Rotates the printed image 180 degrees.



two-sided printing

Use one of the following methods to print two-sided documents:

●     manual two-sided printing 

●     automatic two-sided printing (duplexing) 

manual two-sided printing

printing instructions

Follow these steps to print a two-sided document manually:

1.  Open the Printer Properties dialog box.

2.  Select the Finishing tab.

 

3.  Select Print on Both Sides.

4.  Deselect the Automatic checkbox, then do one of the following:

❍     For book binding: Verify that Flip Pages Up is not selected.



 
1. landscape 2. portrait

❍     For tablet binding: Select Flip Pages Up.

 
1. landscape 2. portrait

5.  Select any other desired print settings, then click OK.

The printer prints the odd-numbered pages first.

6.  Once the odd-numbered pages have printed, reload the paper, with the printed side 
facing up, according to the binding type and orientation selected:

❍     Book binding with portrait orientation: Reload the paper as shown below:

 

❍     Book binding with landscape orientation: Reload the paper as shown below:



 

❍     Tablet binding with portrait orientation: Reload the paper as shown below:

 

❍     Tablet binding with landscape orientation: Reload the paper as shown below:

 

7.  Click Continue to print the even-numbered pages.

automatic two-sided printing (requires accessory)

To print a two-sided document automatically, the Two-Sided Printing Accessory (duplexer) 
must be attached to the printer.

The Two-Sided Printing Accessory (duplexer) only supports certain media types. For a list 
of supported media types, see the documentation that came with the accessory.

Use manual two-sided printing to print on an unsupported media type.

printing instructions

Follow these steps to print a two-sided document automatically:



1.  Open the Printer Properties dialog box.

Select the Finishing tab.

 

2.  Select Print on Both Sides.

3.  Verify that the Automatic checkbox is selected.

4.  Do one of the following:

❍     To automatically resize each page to match the document's onscreen layout: 
Select Preserve Layout.

Not selecting this option may result in unwanted page breaks.

❍     To not resize each page to fit two-sided margins: Verify that Preserve Layout is not 
selected.

5.  Select a binding option:

❍     For book binding: Verify that Flip Pages Up is not selected.



 
1. landscape 2. portrait

❍     For tablet binding: Select Flip Pages Up.

 
1. landscape 2. portrait

6.  Select any other desired print settings, then click OK.

After the first side of the page is printed, the printer pauses while the ink dries. Once the 
ink is dry, the paper is pulled back into the duplexer and the reverse side of the page is 
printed.

 
Do not remove the paper from the duplexer until both sides of the page 
have been printed.



two-sided printing accessory (duplexer)

The duplexer is a special hardware device that enables the printer to automatically print on 
both sides of a page.

Using a duplexer with your printer has several advantages. It allows you to:

●     Print on both sides of a page without manually reloading the page.

●     Print long documents quickly and efficiently.

●     Use less paper by printing on both sides of paper sheets.

●     Create professional-looking brochures, reports, newsletters, and other special items.

If the duplexer is not packaged with your printer, it can be purchased separately from an 
authorized HP dealer.

 The duplexer is not available in all countries/regions.

 

installing the duplexer

Follow these steps to attach the duplexer to your printer:

1.  Push the two latch handles on the printer's Rear Access Door toward each other, 
then remove the door.

 



 
Do not discard the Rear Access Door. In order to print, the 
duplexer or the Rear Access Door must be attached to the printer.

2.  Insert the duplexer in the back of the printer until both sides snap into place.

 

 
Do not press the buttons on either side of the duplexer when 
installing it in the printer. Use the buttons only when removing the 
duplexer from the printer.

printing with the duplexer

For instructions on printing a two-sided document with the duplexer, click here.

For instructions on making automatic two-sided printing the default print setting for your 
printer, click here.

supported media types

The duplexer only works with certain media types. For a list of supported media, see the 
specifications in the documentation that came with the duplexer.



changing default settings

Use the taskbar icon to change the printer's default print settings. The default print 
settings apply to all documents printed by the printer.

 
1. taskbar icon

using the taskbar icon shortcut menu

Follow these steps to change the printer's default settings:

1.  Click the taskbar icon.

The Printer Properties dialog box appears.

2.  Select the options you want to use as the default settings.

3.  Click OK.

A dialog box appears stating that the new settings will be used every time you print. 
If you do not want to see this dialog box again, select Don't show me this message 
again.

4.  Click OK to save the new default print settings.

default print quality

When Print Quality is set to Use Print Quality Selector in the printer software, use the Print 
Quality Selector button to set the default print quality. For information about selecting a 
print quality, click here.



printing a booklet

Booklet printing automatically arranges and resizes the pages of a document so when the 
document is folded into a booklet, the page order is correct.

 

For the appropriate instructions, select one of the following topics:

●     printing a booklet 

●     printing a booklet using the two-sided printing accessory 

printing a booklet

Follow these steps to print a booklet:

1.  Open the Printer Properties dialog box.

2.  Select the Finishing tab.



 

3.  Select Print on Both Sides.

4.  Verify that Automatic is not selected.

5.  Select a binding option in the Booklet Layout is drop-down list:

❍     Right Edge Binding: Places the binding on the right side of the booklet.

 

❍     Left Edge Binding: Places the binding on the left side of the booklet.

 

6.  Do one of the following:

❍     To leave every other page of the booklet blank, select Print On One Side.

❍     To print on all pages in the booklet, leave Print On One Side unchecked.



7.  Select any other desired print settings, then click OK.

8.  When prompted, reload the paper in the In tray as shown below.

 

9.  Click Continue to finish printing the booklet.

printing a booklet using the two-sided printing accessory

Follow these steps to print a booklet using the Two-Sided Printing Accessory:

 
The Two-Sided Printing Accessory is optional. For more information, click 
here.

1.  Open the Printer Properties dialog box.

2.  Select the Finishing tab.

 



3.  Select Print on Both Sides.

4.  Select Automatic.

5.  Select Preserve Layout.

6.  Select a binding option in the Booklet Layout is drop-down list:

❍     Right Edge Binding: Places the binding on the right side of the booklet.

 

❍     Left Edge Binding: Places the binding on the left side of the booklet.

 

7.  Do one of the following:

❍     To leave every other page of the booklet blank, select Print On One Side.

❍     To print on all pages in the booklet, leave Print On One Side unchecked.

8.  Select any other desired print settings, then click OK.



calibrating print cartridges

The printer automatically calibrates the print cartridges after a new print cartridge is 
installed. You can also calibrate the print cartridges at other times to ensure optimal print 
quality.

To calibrate print cartridges:

1.  Load a stack of plain white paper in the In tray.

2.  Go to printer maintenance.

3.  Click Calibrate Printer.

4.  Click Calibrate, then follow the onscreen instructions.



advanced features

Printing photographs, transparencies, or documents with graphics may require you to set 
options on the Advanced Features dialog box.

opening the advanced features dialog box

Follow these steps to open the Advanced Features dialog box:

1.  Open the Printer Properties dialog box.

2.  Click the Basics tab, then click the Advanced Features button.

using the advanced features dialog box

Use the Advanced Features dialog box to set these options:

 

1.  Ink Volume: Adjusts the amount of ink printed on a page. Reducing the ink volume 
reduces the color quality.

2.  Dry Time: Provides extra drying time for slow-drying printouts.

3.  Low Memory Mode: Allows a document to be printed from a computer that does 
not have enough memory or disk space to print the document under normal 
conditions. Using this option may reduce the quality of the printout. The Maximum 
dpi print quality mode is not available when the printer is in Low Memory Mode.



manually cleaning the print cartridges

If the printer is used in a dusty environment, a small amount of debris may accumulate on 
the print cartridge contacts.

gathering cleaning supplies

You will need the following items to clean the print cartridges.

●     Distilled water (tap water may contain contaminants that can damage the print 
cartridge)

●     Cotton swabs or other soft, lint-free material that will not stick to the print cartridge

Be careful not to get ink on your hands or clothing as you clean.

preparing to clean

1.  Press the Power button to turn on the printer, then raise the printer cover.

2.  Remove the print cartridges and place them on a piece of paper with the nozzle 
plate facing up.

 
Do not leave the print cartridges outside the printer for more than 
30 minutes.

cleaning instructions

1.  Lightly moisten a cotton swab with distilled water and squeeze any excess water 
from the swab.

2.  Wipe the print cartridge copper contacts with the cotton swab.

 
Do not touch the print cartridge ink nozzles. Touching the ink 
nozzles will result in clogs, ink failure, and bad electrical 
connections.

 
1. clean only the copper contacts



Repeat this process until no ink residue or dust appears on a clean swab.

3.  Insert the print cartridges in the printer, then close the printer cover.



removing ink from skin and clothing

Follow these instructions to remove ink from skin and clothing:

to remove ink from... do this...

skin Wash the affected area with an abrasive soap.

white fabric Wash the fabric in cold water using chlorine bleach.

color fabric Wash the fabric in cold water using sudsy ammonia.

Caution!   Always use cold water to remove ink from fabric. Warm or hot 
water may set the ink color into the fabric.



automatic paper-type sensor

The Automatic Paper-Type Sensor automatically selects the print settings appropriate for 
the media being printed on, particularly when used with HP paper and media.

When the Automatic Paper-Type Sensor is engaged, the printer scans the first page of a 
document with a blue optical sensor light to determine the best paper-type setting. Once 
the paper-type setting is determined, the page is printed.

For information about using the Automatic Paper-Type Sensor, click here.

 
The Automatic Paper-Type Sensor is not available for documents printed 
from the 250-Sheet Plain Paper Tray Accessory.

 
Do not place the printer in direct sunlight. Direct sunlight can interfere 
with the Automatic Paper-Type Sensor.



selecting a paper type

The printer software offers these options for selecting a paper type:

●     use the automatic paper-type sensor 

●     select a specific paper type 

using the automatic paper-type sensor

The Automatic Paper-Type Sensor automatically selects the print settings appropriate for 
the media be printed on, particularly when used with HP paper and media.

 
The Automatic Paper-Type Sensor cannot be used for documents printed 
from the 250-Sheet Plain Paper Tray Accessory.

Follow these steps to use the automatic paper-type sensor:

1.  Open the Printer Properties dialog box.

2.  Select the Paper/Quality tab.

 

3.  Select Automatic from the Type is drop-down list.

4.  Select any other desired print settings, then click OK.



selecting a specific paper type

When printing a higher-quality printout, it is recommended that you select a specific paper 
type.

Follow these steps to select a specific paper type:

1.  Open the Printer Properties dialog box.

2.  Select the Paper/Quality tab.

 

3.  Select the paper type from the Type is drop-down list.

4.  Select any other desired print settings, then click OK.



USB

The printer connects to the computer with a Universal Serial Bus (USB) cable. The 
computer must be running Windows 98 or later to use a USB cable.

 

For instructions on connecting the printer with a USB cable, see the setup poster that came 
with the printer.



connectivity

●     USB 

●     parallel 

●     network 

❍     wired networking 

❍     wireless networking 



parallel

The printer connects to the computer with a parallel cable.

 

For instructions on connecting with a parallel cable, see the setup poster that came with 
the printer.



network

Select the appropriate networking option:

●     wired networking 

●     wireless networking 



wired networking

connecting via a networked computer

The printer can be connected directly to a computer on a network and then shared with 
other computers on the network.

For instructions on sharing the printer on a network, use the printer software CD and follow 
the onscreen network setup instructions.

using an hp jetdirect print server

The printer can be connected to a network with an HP Jetdirect Print Server.

For instructions on using an HP Jetdirect Print Server, use the printer software CD and the 
documentation that came with the print server.

To view available wired networking documentation, click here.



hp deskjet 5600 series printer 

user's documentation menu 

●     printer user's guide 

●     network printing

❍     

network basics tutorial

❍     wireless networking

■     hp jetdirect 380x 

■     hp wp110 

❍     wired networking

■     hp jetdirect 175x 

■     hp jetdirect 310x 



hp jetdirect 380x documentation

Print servers allow you to connect your printer directly to a network, placing it at a 
convenient location. Any computer on the network can use the printer, without requiring 
any other computer on line.

hp J6061A jetdirect 380x 

●     USB printer connection
●     802.11b (Wi-Fi) wireless network connection, with encryption, and 802.1x, EAP-

MD5, EAP-TLS authentication
●     TCP/IP, IPX/SPX, Novell NetWare, Apple EtherTalk, Unix/Linux networks
●     Windows 95, 98, 2000, Me, XP, NT 4.0, MacOS computers

Click one of the options below to view the available documentation:

●     

setup guide
●     

administrator's guide



hp wp110 print server documentation

Print servers allow you to connect your printer directly to a network, placing it at a 
convenient location. Any computer on the network can use the printer, without requiring 
any other computer on line.

hp J6062A wp110 

●     Parallel printer connection
●     802.11b (Wi-Fi) wireless network connection, with encryption, and 802.1x, EAP-

MD5, EAP-TLS authentication
●     TCP/IP, IPX/SPX, Novell NetWare, Apple EtherTalk, Unix/Linux networks
●     Windows 98, 2000, Me, XP, NT 4.0, MacOS computers

Click one of the options below to view the available documentation:

●     

setup guide
●     

configuration guide



hp jetdirect 175x documentation

Print servers allow you to connect your printer directly to a network, placing it at a 
convenient location. Any computer on the network can use the printer, without requiring 
any other computer on line.

hp J6035A jetdirect 175x 

●     USB printer connection
●     100Base-Tx (Fast Ethernet) and/or 10Base-T (Ethernet) network connection
●     TCP/IP, IPX/SPX direct mode, Apple EtherTalk networks
●     Windows 95, 98, 2000, Me, XP, NT 4.0, MacOS computers

Click the option below to view the available documentation:

●     

user's guide



hp jetdirect 310x documentation

Print servers allow you to connect your printer directly to a network, placing it at a 
convenient location. The hp jetdirect 310x Fast Ethernetexternal print server is a simple 
and reliable way to share a broad range ofnetwork-capable HP printers with USB ports on a 
network and across the Internet in any major operating environment.

hp J6035A#aba jetdirect 310x 

●     USB printer connection
●     Ethernet and Fast Ethernet
●     Embedded Web server
●     TCP/IP, IPX/SPX direct mode, Apple EtherTalk networks
●     DLC/LLC, FTP and IPP
●     Windows 95, 98, 2000, Me, XP, and NT 4.0, MacOS, Novell NetWare, HP-UX, Solaris 

(on SPARC systems), SCO UNIX, LINUX, IBM AIX, MPE-IX, and Artisoft LANtastic

Click the option below to view the available documentation:

●     

user's guide



wireless networking

The printer can be connected to a wireless network with an HP Jetdirect Wireless Print 
Server.

For instructions on using an HP Jetdirect Wireless Print Server, use the printer software CD 
and the documentation that came with the wireless print server.

To view available wireless networking documentation, click here.



printing

Click the appropriate topic below to view an explanation of the printer software:

●     print settings 

●     advanced features 

●     device status box 

Click the appropriate topic below to view instructions on printing functions:

●     printing a document 

●     changing default settings 

●     printing digital photographs 

●     digital photography technologies 

●     two-sided printing 

●     print task quick sets 

●     borderless printing 

●     setting a custom paper size 

●     selecting a print quality 

●     selecting a paper source 

●     selecting a paper type 

●     printing a booklet 

●     printing multiple pages on a single sheet of paper 

●     printing a screen image 

●     watermarks 

Click the appropriate topic below to view instructions for printing on various types of media:

●     plain paper 

●     envelopes 

●     transparencies 

●     labels 

●     index cards and other small media 

●     greeting cards 

●     hagaki cards 



●     photographs 

●     posters 

●     banners 

●     iron-on transfers 



device status box

The Device Status Box appears each time the printer prints a file.

 

The following items are displayed:

1.  Ink Levels: Approximate ink level of each print cartridge.

2.  Device Status: The status of the printer. For example, Spooling or Printing.

3.  Document Properties: The following information about the current print job is 
provided.

❍     Document: Name of the document that is currently printing.

❍     Print Quality: Print quality setting being used.

❍     Paper Type: Type of paper used.

❍     Paper Size: Size of paper used.

To cancel a print job, click Cancel Print.

To close the Device Status Box, click Close Window.



printing a document

basic printing instructions

Follow these steps to print a document:

1.  Open the file you want to print.

2.  Click File > Print.

3.  Click OK to print with the printer's default print settings.

setting printing options

Follow these steps to change printing options:

1.  Open the file you want to print.

2.  Click File > Print, then select Properties.

The Printer Properties dialog box appears.

 
The path to the Printer Properties dialog box may vary depending 
on the software program.

3.  Specify the print settings shown below:

❍     Select the Paper/Quality tab to choose paper options, paper sources, borderless 
printing, and print quality, or to access the HP digital photography options.

If you want to use preset print settings, choose a Print Task Quick Set.

❍     Select the Finishing tab to choose document options, print posters, or rotate the 
printed image by 180 degrees.

❍     Select the Effects tab to choose resizing options and watermarks.

❍     Select the Basics tab to choose orientation and page order options, specify the 
number of copies printed, enable Show Print Preview, or to access Advanced 
Features.

❍     Select the Color tab to choose color options and color attributes.

4.  Click OK, then follow the application's instructions to print the document.



posters

guidelines

●     After the sections of a poster have been printed, trim the edges of the sheets, then 
tape the sheets together.

 

●     In tray capacity: Up to 150 sheets

preparing to print

1.  Remove all paper from the In tray.

2.  Slide the paper width guide all the way to the left, then pull out the paper length 
guide.

3.  Place plain paper in the In tray, pushing the paper into the printer until it stops.

4.  Slide the paper guides firmly against the paper.

 

printing

1.  Open the Printer Properties dialog box, then select the following:

tab setting



Paper/
Quality 

Size is: Appropriate size
Source is: Upper Tray or Lower Tray
Type is: Automatic or Plain Paper

Finishing Poster Printing: 2 x 2, 3 x 3, 4 x 4, or 5 x 5

Basics Orientation: Appropriate orientation

2.  Select any other desired print settings, then click OK.



effects tab

The Effects tab allows you to set the following options:

 

1.  Print Task Quick Sets: See print task quick sets.

2.  Print Document On: Prints a document on a paper size different than the paper 
size for which it is formatted. Select the target paper size from the drop-down list.

3.  Scale to Fit: Automatically resizes the printed image to fit on the paper size 
selected in the Print Document On drop-down list.

4.  % of Normal Size: Specify the percentage to which you want to reduce or enlarge 
the printed image. For example, enter 70 to reduce the printed image to 70 percent 
of its normal size.

5.  Watermarks: See watermarks.



watermarks

Watermarks appear as background printing on documents.

applying an existing watermark to a document

Follow these steps to apply an existing watermark to a document:

1.  Open the Printer Properties dialog box.

2.  Click the Effects tab.

 

3.  Select a watermark from the Watermarks drop-down list.

If you do not want to use one of the listed watermarks, create a new watermark.

4.  Do one of the following:

❍     If you want the watermark to appear on the first page only, select First Page Only.

❍     If you want the watermark to appear on all printed pages, leave First Page Only 
unchecked.

5.  Print the document according to the instructions for the paper type.



creating or changing a watermark

Follow these steps to create or change a watermark:

1.  Open the Printer Properties dialog box.

2.  Click the Effects tab.

3.  Click the Edit button.

The Watermark Details dialog box appears.

 

4.  Do one of the following:

❍     Click the New button, or

❍     Select an existing watermark to change.

5.  Enter the watermark message, message angle, and font attributes.

6.  After you have set the watermark details, click OK.

For instructions on applying watermarks, click here.

 
To find more information about options on each tab screen, point to an 
option and click the right mouse button to display the What's This? dialog 
box. Click What's This? to view more information about the selected item.



basics tab

The Basics tab allows you to set the following options:

 

1.  Print Task Quick Sets: See print task quick sets.

2.  Orientation: Specify the page layout:

❍     Portrait: The printed page is longer than it is wide.

❍     Landscape: The printed page is wider than it is long.

❍     Mirror Image: Reverses the printed image from left to right.

3.  Page Order: Select one of the following:

❍     Front to Back: First page will be on top when the document is finished 
printing.

❍     Back to Front: Last page will be on top when the document is finished 
printing.

4.  Copies: Use to print multiple copies of a document.

❍     Copy Count: Number of copies printed.

❍     Collate: Prints each copy of the document in its entirety when printing 
multiple copies.



5.  Print Preview: Select to view the layout of a document before it prints.

6.  Advanced Features: See advanced features.



plain paper

guidelines

In tray capacity: Up to 150 sheets

preparing to print

1.  Remove all paper from the In tray.

2.  Slide the paper width guide all the way to the left, then pull out the paper length 
guide.

3.  Place plain paper in the In tray, pushing the paper into the printer until it stops.

4.  Slide the paper guides firmly against the paper.

 
1. letter paper

 
2. legal paper

loading the 250-sheet plain paper tray accessory

For instructions on loading the 250-Sheet Plain Paper Tray Accessory, click here.

 
If the 250-Sheet Plain Paper Tray Accessory is not included with your 
printer, it may be purchased separately from an authorized HP dealer. The 
accessory is not available in all countries/regions.

printing



1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality 

Size is: Appropriate paper size
Source is: Upper Tray
Type is: Automatic or Plain Paper

 
If you have the 250-Sheet Plain Paper Tray Accessory installed, 
choose Lower Tray in Source is, and choose Plain Paper in Type 
is.

2.  Select any other desired print settings, then click OK.



envelopes

guidelines

●     Avoid using envelopes that: have clasps or windows; have thick, irregular, or curled 
edges; are shiny or embossed; are wrinkled, torn, or otherwise damaged.

●     Align the envelope edges before inserting them in the In tray.

●     In tray capacity: Up to 20 envelopes

preparing to print

1.  Remove the Out tray, then remove all paper from the In tray.

 

2.  Slide the paper width guide all the way to the left, then pull out the paper length 
guide.

3.  Place the envelopes, with the printable side down and the flap to the left, in the 
right side of the In tray. Push the envelopes into the printer until they stop.

4.  Slide the paper guides firmly against the envelopes.

 

5.  Replace the Out tray.



 

printing

1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality 

Size is: Appropriate envelope size
Type is: Automatic or Plain Paper

2.  Select any other desired print settings, then click OK.



transparencies

guidelines

●     For great results, use HP brand inkjet transparency film.

●     In tray capacity: Up to 20 sheets

preparing to print

1.  Remove all paper from the In tray.

2.  Slide the paper width guide all the way to the left, then pull out the paper length 
guide.

3.  Place the transparencies in the In tray, with the printable side down and the 
adhesive strip facing up and toward the printer.

 

4.  Carefully push the transparencies into the printer until they stop so that none of the 
adhesive strips catch on one another.

5.  Slide the paper guides firmly against the edge of the transparencies.

printing

1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality 

Source is: Upper Tray
Type is: Appropriate transparency film

2.  Select any other desired print settings, then click OK.



labels

guidelines

●     Use only paper labels that are designed specifically for inkjet printers.

●     Use only full sheets of labels.

●     Verify that the labels are not sticky, wrinkled, or pulling away from the protective 
backing.

●     Do not use plastic or clear labels. The ink will not dry on these labels.

●     In tray capacity: Up to 20 sheets

preparing to print

1.  Remove all paper from the In tray.

2.  Slide the paper width guide all the way to the left, then pull out the paper length 
guide.

3.  Fan the edges of the label sheets to separate them, then align the edges.

4.  Place the label sheets in the In tray with the label side down. Push the sheets into 
the printer until they stop.

 

5.  Slide the paper guides firmly against the edge of the sheets.

printing

1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality 

Size is: Letter or A4
Source is: Upper Tray
Type is: Automatic or Plain Paper



2.  Select any other desired print settings, then click OK.



index cards and other small media

guidelines

●     Use only cards and small media that meet the printer's paper size specifications. For 
specifications, see the reference guide that came with the printer.

●     For instructions on borderless printing, click here.

●     In tray capacity: Up to 60 cards

preparing to print

1.  Remove the Out tray, then remove all paper from the In tray.

 

2.  Slide the paper width guide all the way to the left, then pull out the paper length 
guide.

3.  Place the cards, with the printable side down and one of the short sides pointing 
towards the printer, in the right side of the In tray.

4.  Push the cards into the printer until they stop.

5.  Slide the paper guides firmly against the cards.

 

6.  Replace the Out tray.



 

printing

1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality 

Source is: Upper Tray
Size is: Appropriate paper size
Type is: Appropriate paper type
Print Quality: Normal or Best

2.  Select any other desired print settings, then click OK.



greeting cards

guidelines

●     Unfold pre-folded cards, then place them in the In tray.

●     For great results, use HP Greeting Card Paper.

●     In tray capacity: Up to 20 greeting cards

preparing to print

1.  Remove all paper from the In tray.

2.  Slide the paper width guide all the way to the left, then pull out the paper length 
guide.

3.  Fan the edges of the greeting cards to separate them, then align the edges.

4.  Place the greeting cards in the In tray, with the side to be printed facing down. Push 
the cards into the printer until they stop.

 

5.  Slide the paper guides firmly against the paper.

printing

 
If your software program includes a greeting card printing feature, follow 
the instructions provided with the software program. Otherwise, follow the 
instructions below.

1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality 

Size is: Appropriate card size
Source is: Upper Tray
Type is: Appropriate card type



2.  Select any other desired print settings, then click OK.



hagaki cards

guidelines

●     Use only cards and small media that meet the printer's paper size specifications. For 
specifications, see the reference guide that came with the printer.

●     For instructions on borderless printing, click here.

●     In tray capacity: Up to 60 cards

preparing to print

1.  Remove the Out tray, then remove all paper from the In tray.

 

2.  Slide the paper width guide all the way to the left, then pull out the paper length 
guide.

3.  Place the cards, with the printable side down and one of the short sides pointing 
towards the printer, in the right side of the In tray.

4.  Push the cards into the printer until they stop.

5.  Slide the paper guides firmly against the cards.

 

6.  Replace the Out tray.



 

printing

1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality 

Source is: Upper Tray
Size is: An available hagaki or borderless hagaki card size
Type is: An available hagaki paper type
Print Quality: Normal or Best

2.  Select any other desired print settings, then click OK.



photographs

guidelines

●     For outstanding results, use HP brand photo paper.

●     For high-quality results, use a high-resolution print setting, install a photo print 
cartridge in the printer, and set the HP digital photography options.

●     For maximum fade resistance, use HP Premium Plus Photo Paper and install a photo 
print cartridge in the printer.

●     For instructions on borderless printing, click here.

●     For information on preventing photo paper from curling, click here.

●     For information on various photo printing technologies, click here.

●     In tray capacity: Up to 20 sheets

preparing to print

1.  Remove the Out tray, then remove all paper from the In tray.

 

2.  Slide the paper width guide all the way to the left, then pull out the paper length 
guide.

3.  Verify that the photo paper is flat.

4.  Do one of the following:

❍     Small photographs: Place the photo paper in the In tray, with the printable side 
down and one of the short edges pointing towards the printer.

If you are using a photo paper that has a tear-off tab, verify that the tab is 
pointing away from the printer.



 

❍     Large photographs: Place the photo paper in the In tray with the printable side 
down.

 

5.  Slide the paper guides firmly against the paper.

6.  Replace the Out tray.

 

printing

 
If your software program includes a photo printing feature, follow the 
instructions provided with the software program. Otherwise, follow the 
instructions below.

1.  Open the Printer Properties dialog box, then select the following:

tab setting



Paper/
Quality 

Size is: Appropriate photo paper size
Source is: Upper Tray
Type is: Appropriate HP photo paper type
Print Quality: Normal, Best, or Maximum dpi
hp Digital Photography: Desired photo enhancement options

2.  Select any other desired print settings, then click OK.



banners

guidelines

●     Use HP banner paper for great results.

●     Remove any perforated strips from the banner paper before loading it in the In tray.

 

●     In tray capacity: Up to 20 continuous sheets

preparing to print

1.  Remove all paper from the In tray.

2.  Slide the paper width guide all the way to the left, then pull out the paper length 
guide.

 Do not unfold the Out tray extension stop.

3.  Place the banner paper in the In tray so that the unattached edge is on top of the 
paper stack pointing toward the printer.

 
1. unattached edge

4.  Slide the paper width guide firmly against the paper.

printing

 
If your software program includes a banner printing feature, follow the 
instructions provided with the software program. Otherwise, follow the 
instructions below.



1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality 

Size is: Letter or A4
Source is: Upper Tray
Type is: hp banner paper

2.  Select any other desired print settings, then click OK.



iron-on transfers

guidelines

●     Use HP Iron-on Transfers for great results.

●     When printing a mirror image, the text and the pictures are horizontally reversed 
from what appears on the computer screen.

 

●     In tray capacity: Up to 20 sheets

preparing to print

1.  Remove all paper from the In tray.

2.  Slide the paper width guide all the way to the left, then pull out the paper length 
guide.

3.  Place the iron-on transfer paper in the In tray with the printable side down. Push the 
paper into the printer until it stops.

 

4.  Slide the paper guides firmly against the paper.

printing

 
If your software program includes an iron-on transfer printing feature, 
follow the instructions provided with the software program. Otherwise, 
follow the instructions below.

1.  Open the Printer Properties dialog box, then select the following:



tab setting

Paper/
Quality 

Size is: Appropriate paper size
Source is: Upper Tray
Type is: hp iron-on transfer
Print Quality: Normal or Best

Basics Orientation: Mirror Image

2.  Select any other desired print settings, then click OK.



maintenance

●     replacing print cartridges 

●     calibrating print cartridges 

●     calibrating color 

●     automatically cleaning print cartridges 

●     manually cleaning the print cartridges 

●     auto-on and auto-off feature 

●     maintaining print cartridges 

●     storing and handling photo paper 

●     maintaining the printer body 

●     removing ink from skin and clothing 

●     printer tools 



calibrating color

Perform a color calibration only if the colors in photographs printed with the photo print 
cartridge are consistently tinted.

Before preforming a color calibration, calibrate the printer, then reprint your photograph. If 
the color is still tinted, then perform a color calibration.

To calibrate color:

1.  Load plain white paper in the In tray.

2.  Verify that a photo print cartridge is installed in the printer.

3.  Go to printer maintenance.

4.  Click Calibrate Color.

5.  Click Calibrate, then follow the onscreen instructions.



automatically cleaning print cartridges

If your printed pages are missing lines or dots, or if they contain ink streaks, the print 
cartridges may be low on ink or may need to be cleaned.

Click here to check the print cartridge ink levels.

If the print cartridges are not low on ink, follow these steps to clean the print cartridges 
automatically:

1.  Go to printer maintenance.

2.  Click Clean Cartridges.

3.  Click Clean, then follow the onscreen instructions.

If your printouts are still missing lines or dots after cleaning, replace the print cartridges.

Caution!   Clean print cartridges only when it is necessary. Unnecessary 
cleaning wastes ink and shortens the life of the cartridge.



maintaining the printer body

Because the printer ejects ink onto the paper in a fine mist, ink smudges will eventually 
appear on the printer case and adjacent surfaces. To remove smudges, stains, and/or 
dried ink from the exterior of the printer, use a soft cloth moistened with water.

When cleaning your printer, keep these tips in mind:

 

●     Do not clean the interior of the printer. Keep all fluids away from the 
interior.

●     Do not use household cleaners or detergent. In the event that a household 
cleaner or detergent is used on the printer, wipe the printer's exterior 
surfaces with a soft cloth moistened with water.

●     Do not lubricate the support rod that the print cartridge cradle uses to slide 
back and forth. Noise is normal when the cradle moves back and forth.



printer tools

The printer software contains a number of useful tools to enhance the printer's 
performance.

Use the printer tools to:

●     View estimated ink levels.

●     Clean the print cartridges.

●     Calibrate the printer.

●     Print a test page.

●     Perform other functions as needed.

To access the tools, click here.



troubleshooting

●     printer is not printing 

●     paper jam 

●     paper problems 

●     print quality is poor 

●     document is misprinted 

●     photos are not printing correctly 

●     borderless printing problems 

●     banners are not printing correctly 

●     error messages 

●     printer lights are on or flashing 

●     printer is slow 

●     automatic two-sided printing problems 

●     if you continue to have problems 



printer is not printing

verify the following

●     Printer is connected to the power source.

●     Cable connections are secure.

●     Printer is turned on.

●     Print cartridges are correctly installed.

●     Paper or other media is correctly loaded in the In tray.

●     Printer's top cover is closed.

●     Rear Access Door or optional duplexer is attached.

check the printer lights

The printer lights indicate printer status and alert you to potential problems.

For more information, see printer lights are on or flashing.

check the printer cable connection

If you are using a USB printer cable and the cable is attached to a USB hub, there may be 
a printing conflict. There are two methods for solving the conflict:

●     Attach the printer's USB cable directly to your computer, or

●     When printing, do not use other USB devices that are attached to the hub.

if the printer does not turn on

The printer may have drawn too much power.

1.  Disconnect the power cord from the electrical outlet.

2.  Wait approximately 10 seconds.

3.  Reconnect the power cord.

4.  Press the Power button to turn on the printer.

If the printer still does not turn on, try the following:

●     Plug the printer into another electrical outlet, or

●     Plug the printer directly into an electrical outlet rather than into a surge protector.

if the printer still does not print

Select the topic below that best describes the problem:



●     paper jam 

●     out of paper message 

●     printer ejects paper 



error messages

out of paper message

if the in tray or optional lower tray contains paper

1.  Verify the following:

❍     There is sufficient paper in the paper tray (at least ten sheets).

❍     The paper tray is not overly full.

❍     The paper stack is touching the back of the paper tray.

2.  Slide the paper guides so they fit firmly against the edges of the paper.

3.  Press the Resume button to continue printing.

if the in tray or optional lower tray is empty

1.  Load paper in the tray.

2.  Press the Resume button to continue printing.

the error message 'there was an error writing to USB port' appears

If you are using a USB printer cable, the printer may not be receiving correct data from 
another USB device or USB hub. Connect the printer directly to the USB port on the 
computer.

the error message 'there was an error writing to LPT1' appears

If the printer is connected to the computer with a USB cable, the cable may not have been 
attached before installing the software.

Uninstall, then reinstall, the software.

To uninstall the software, click here.

the error message 'two-way communication cannot be established' or 'printer not 
responding' appears

The printer may not be able to communicate with the computer if the USB cable is too long.

If you receive this error message, ensure the USB cable is not greater than five meters 
(approximately 16 feet, five inches) in length.



 

printer assistant home 

back 

search 

print 

 

 

 

  exit 

 

uninstall software

uninstall driver

Select "uninstall" to remove the printer driver 

from the computer. Printing will no longer be 

possible. The printer driver must be re-

installed before printing again.

 



paper problems

printer ejects the paper

If the printer ejects the paper, do one of the following:

●     Move the printer away from direct sunlight. The printer may have been placed in 
direct sunlight which can affect the Automatic Paper-Type Sensor.

●     Select a paper type other than Automatic.

●     If you are performing a color calibration, install both the tri-color and photo print 
cartridges.

●     If you are printing a borderless document and the Resume light and Print Cartridge 
Status light are flashing, follow these guidelines.

other paper problems

●     For information on clearing a paper jam, click here.

●     If an out of paper message appears, click here.



print quality is poor

streaks and missing lines

If your printed pages are missing lines or dots or if streaks appear, the print cartridges 
may be low on ink or may need to be cleaned.

print is faded

●     Verify that a black print cartridge is installed.

If the black text and images on your printouts are faded, you may be printing using 
only the tri-color print cartridge. Insert a black print cartridge, in addition to the tri-
color print cartridge, for optimal black print quality.

●     Verify that neither of the print cartridges is low on ink.

If a print cartridge is low on ink, consider replacing the print cartridge. For the 
correct part numbers, see print cartridges.

●     Verify that the protective piece of plastic tape has been removed from the print 
cartridges.

 
1. plastic tape

●     Consider selecting a higher print quality.

blank pages print

●     The protective piece of plastic tape may still be attached to the print cartridges. 
Verify that the plastic tape has been removed from the print cartridges.

●     The print cartridges may be out of ink. Replace one or both empty print cartridges.

too much or too little ink appears on the page

adjust the ink volume and dry time

1.  Open the Advanced Features dialog box.

2.  Move the Ink Volume slider toward Light or Heavy.



 
If you increase the ink volume, move the Dry Time slider toward 
More to avoid smearing the ink.

3.  Click OK, then click OK again.

select a specific paper type

1.  Open the Printer Properties dialog box.

2.  Select the Paper/Quality tab.

3.  In the Type is field, select an appropriate paper type. Do not select Automatic.



document is misprinted

text and images are misaligned

If the text and images on your printouts are misaligned, then calibrate the printer.

document is printed off-center or at an angle

1.  Verify that the paper is correctly placed in the In tray or optional lower tray.

2.  Verify that the paper guides fit firmly against the paper.

3.  Reprint the document.

parts of the document are missing or printed in the wrong place

Open the Printer Properties and confirm the following options:

tab setting

Basics Orientation: Verify the appropriate orientation

Paper/
Quality Size is: Verify the appropriate paper size

Effects Scale to Fit: Select to scale text and graphics to the paper

Finishing Poster Printing: Verify that Off is selected

envelope is printed at an angle

1.  Slide the flap inside the envelope before loading it in the printer.

2.  Confirm that the paper guides fit firmly against the envelope.

3.  Reprint the envelope.

printout does not reflect new print settings

The printer's default settings may differ from the software application's print settings. 
Select the appropriate print settings within the software application.



photos are not printing correctly

check the paper trays

1.  Verify that the photo paper is placed in the In tray with the printable side down.

2.  Slide the paper forward until it stops.

3.  Slide the paper guides firmly against the paper.

check the printer properties

Open the Printer Properties dialog box and verify the following options:

tab setting

Paper/
Quality 

Size is: Appropriate size
Type is: Photo Paper
Print Quality: Best

colors are tinted or incorrect

If colors in photographs appear tinted or incorrect, follow these steps:

1.  Calibrate the print cartridges.

2.  Reprint the photograph.

3.  If colors are still tinted or incorrect, calibrate the color.

A photo print cartridge must be installed for color calibration.

4.  Reprint the photograph.

5.  If colors are still tinted or incorrect, then open the Printer Properties dialog box, 
select the Color tab, then do the following:

❍     If the colors are too yellow, move the Color Tone slider towards Cooler.

❍     If the colors are too blue, move the Color Tone slider towards Warmer.

6.  Reprint the photograph.

7.  If colors are still tinted or incorrect, calibrate the print cartridges.

part of the photograph is faded

fading occurs on the edges of a printout



 

Verify that photo paper is not curled. If the photo paper is curled, place the paper in a 
plastic bag and gently bend it the opposite direction of the curl until the paper lies flat. If 
the problem persists, then use photo paper that is not curled.

For instructions on preventing photo paper from curling, click here.

fading occurs near the edges of a printout

 

If fading occurs approximately 1 to 2.5 inches from the edge of a photograph, try the 
following:

●     Install a photo print cartridge in the printer.

●     Open the Printer Properties dialog box, select the Paper Type/Quality tab, then set 
the Print Quality to Maximum dpi.

●     Rotate the image 180 degrees.



banners are not printing correctly

check the paper tray

●     Unfold and refold the paper when several sheets feed into the printer at once.

●     Confirm that the unattached edge of the banner paper stack is on top and facing the 
printer.

●     Verify that the correct paper for banner printing is used.

check the printer properties

Open the Printer Properties dialog box and verify the following settings:

tab setting

Paper/
Quality 

Size is: Appropriate banner size
Type is: hp banner paper

check the software

●     Verify that the software application you are using prints banners. Not all software 
applications print banners.

●     If gaps appear at the ends of the sheets, verify that the printer software is operating 
correctly.



printer is slow

Several variables can slow the printer's performance.

multiple software applications are open

The computer does not have sufficient resources for the printer to print at its optimum 
speed.

To increase printer speed, close all unnecessary software applications when printing.

complex documents, graphics, or photographs are printing

Documents containing graphics or photographs print slower than text documents.

If your computer does not have enough memory or disk space to print the document under 
normal conditions, you can use Low Memory Mode. Using this option may reduce the 
quality of the printout. Low Memory Mode also disables 4800 x 1200 optimized dpi printing.

To activate Low Memory Mode:

1.  Open the Printer Properties dialog box.

2.  Click the Basics tab, then click the Advanced Features button.

3.  Select Low Memory Mode.

4.  Print the document.

best or maximum dpi print mode is selected

The printer prints slower when Best or Maximum dpi is selected as the print quality. To 
increase the printer speed, select a different print quality mode.

printer driver is outdated

An outdated printer driver may be installed.

For information about updating the printer driver, click here.

automatic paper type option is enabled

When the automatic paper type option is enabled, it takes a few seconds for the printer to 
scan the first page of the print job to determine the appropriate paper type.

To increase the print speed, turn off the Automatic Paper-Type Sensor.

two-sided documents are printing

Printing two-sided documents takes more time than printing single-sided documents.

To increase speed, open the Advanced Features dialog box, then move the Dry Time slider 
to Less.



computer does not meet system requirements

If your computer does not have enough RAM or a large amount of free space on the hard 
drive, the printer processing time will be longer.

1.  Verify that the computer's hard disk space, RAM, and processor speed meet system 
requirements.

2.  Free up space on the hard drive.

printer is in ink-backup mode

The printer may print more slowly if it is in ink-backup mode.

To increase the print speed, use two print cartridges in the printer.
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update software

update driver

Visit HP's website to download current printer 

driver updates.

Current driver version: 

go to web 



minimum system requirements

Your computer must meet the following minimum requirements:

Microsoft Windows XP

Minimum processor speed: Pentium II 233 MHz

Required RAM: 128 MB

Required free hard disk space: 175 MB*

Microsoft Windows NT4 or 2000 Professional

Minimum processor speed: Pentium II 133 MHz

Required RAM: 64 MB

Required free hard disk space: 175 MB*

Microsoft Windows 98, Me

Minimum processor speed: Pentium 150 MHz

Required RAM: 32 MB

Required free hard disk space: 175 MB*

* If you are printing photographs, or printing very high resolution (4800 x 1200 
optimized dpi), you must have at least 400 MB of temporary hard disk space available.



automatic two-sided printing problems

(if optional Two-Sided Printing Accessory is attached to printer) 

paper jam occurs inside the two-sided printing accessory

See paper jam for instructions.

option for two-sided printing cannot be selected

Verify the following:

●     The Two-Sided Printing Accessory (duplexer) is attached to the printer.

●     The duplexer is enabled in the printer software.

●     The media type and size selected in the Paper/Quality tab are supported by the 
duplexer.

See the documentation that came with the duplexer for a list of supported media 
types and sizes.

only one side of the page prints when the two-sided printing option is enabled

Verify the following:

●     The correct print options are set in both the printer software and the application you 
are using.

●     The photo paper is not curled, if you are printing on two-sided photo paper. Photo 
paper should be flat before printing. See storing and handling photo paper for more 
information.

●     The media type and size selected in the Paper/Quality tab are supported by the 
duplexer.

See the documentation that came with the duplexer for a list of supported media 
types and sizes.

If the media type or size is not supported by the duplexer, you can print the 
document using the manual two-sided printing feature.

binding margin is in the wrong place

1.  Open the Printer Properties dialog box.

2.  Select the Finishing tab.

3.  Verify that:

❍     Flip Pages Up is selected for binding along the top (tablet binding).

❍     Flip Pages Up is not selected for binding along the side (book binding).



For more information, see two-sided printing.

paper size changes when the two-sided printing option is selected

The paper size is not supported by the duplexer.

See the documentation that came with the duplexer for a list of supported paper sizes.



if you continue to have problems

If you continue to have problems after investigating the troubleshooting topics, shut down, 
then restart your computer.

If you still have problems after restarting your computer, go to HP customer support at 
www.hp.com/support.



specifications

●     printer specifications 

●     minimum system requirements 

●     environmental statement 

●     print cartridge recovery 



printer specifications

See the reference guide packaged with your printer for complete printer specifications, 
including:

●     Types, sizes, and weights of paper and other printing media that can be used with 
your printer

●     Print speeds and resolutions

●     Power requirements



environmental statement

Hewlett-Packard continuously improves the design processes of its deskjet printers to 
minimize the negative impact on the office environment and on the communities where 
printers are manufactured, shipped, and used.

reduction and elimination

Paper use: The printer's two-sided printing capability reduces paper usage and the 
resulting demands on natural resources. This printer is suited for the use of recycled 
papers in accordance with DIN 19 309.

Recycled paper: All paper documentation for this printer is printed on recycled paper.

Ozone: Ozone-depleting chemicals such as CFCs have been eliminated from Hewlett-
Packard's manufacturing processes.

recycling

Design for recycling has been incorporated into this printer. The number of materials has 
been kept to a minimum while ensuring proper functionality and reliability. Dissimilar 
materials have been designed to separate easily. Fasteners and other connections are easy 
to locate, access, and remove using common tools. High priority parts have been designed 
to access quickly for efficient disassembly and repair.

Printer packaging: The packaging materials for this printer have been selected to provide 
maximum protection for the least cost possible, while attempting to minimize 
environmental impact and facilitate recycling. The rugged design of the HP Deskjet printer 
assists in minimizing both packaging materials and damage rates.

Plastic parts: All major plastics and plastic parts are marked according to international 
standards. All plastic parts used in the printer housing and chassis are technically 
recyclable and all use a single polymer.

Product longevity: To ensure the longevity of your HP Deskjet printer, HP provides the 
following:

●     Extended warranty: Details can be found in the reference guide that came with 
your printer.

●     Replacement parts and consumables are available for three (3) years after 
production has stopped.

●     Product take-back: To return this product to HP at the end of its useful life, go to 
www.hp.com/recycle. To return empty print cartridges to HP, see print cartridge 
recovery.

 
The extended warranty and product take-back options are not 
available in all countries/regions.



energy consumption

This printer was designed with energy conservation in mind. Not only does this save 
natural resources, but it also saves money without affecting the high performance of the 
printer.

This product qualifies for the ENERGY STAR® Program. ENERGY STAR is a voluntary 
program established to encourage the development of energy-efficient office products.

 

ENERGY STAR is a U.S. registered service mark of the U.S. Environmental Protection 
Agency. As an ENERGY STAR partner, Hewlett-Packard Company has determined that this 
product meets ENERGY STAR guidelines for energy efficiency.

Energy consumption in standby mode: See the reference guide for energy 
consumption specifications.

Energy consumption in off-mode: When the printer is off, an amount of energy is still 
being consumed. Energy consumption can be prevented by turning the printer power off, 
then disconnecting the end of the printer power cord from the electrical source.



user's guide other languages 

The User's Guide information is available in Adobe Acrobat format in the following 
languages. Select from the choices below: 
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support

HP's Customer Care provides expert support, 

advice on using HP printers and help solving 

printing problems.

Note: Support options and availability vary by 

product, country/region and language.
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printing ideas

Quickly learn how to print envelopes, labels, 

and photos, and use other HP convenience 

features such as two-sided printing and 

printing a screen image.
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supplies

Find out about HP printer supplies and other 

HP products here.
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